
Hints and tips

Overview

This chapter provides some hints to speed up your 
work. 

Section FAQ gives you tips which result from the 
daily work with FrameMaker. For experts they may 
seem obvious, but not so for beginners.

For a complete list of all FrameMaker 6 commands 
(both for the German and English FrameMaker) see 
www.daube.ch/docu/fmaker08.html
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Keyboard input

Short-cuts
Any FrameMaker function can be invoked from the keyboard. 
ESC sequences (for example, ESC, o, F) are independent of plat-
form, but depend on the User Interface (UI) language. Short-
cuts using special keys depend on platform and (often) UI.

Purpose English FrameMaker version (Win) Deutsche FrameMaker version (Win)

Format paragraph a)  F9, para_stylename, RET F9, para_stylename, RET

Format characters a.) F8, char_stylename, RET F8, char_stylename, RET

Select graphic object CTRL+click on object CTRL+click on object

Select 1st / next drawn object ESC, o, F ESC, o, F

Select next drawn object ESC, o, n ESC, o, n

Keep graphic tool SHIFT+click the tool SHIFT+click the tool

Properties of selected / current object ALT+g, p ALT+g, o

Open Paragraph designer CTRL+m CTRL+m

Open Character designer CTRL+d CTRL+d

Open Table designer CTRL+t CTRL+t

Repeat last character modification ESC, c, c ESC, z, w

Repeat last paragraph modification ESC, j, j ESC, A, W

Straight single quote ESC, CTRL+'

Straight double quote ESC, " (SHIFT+2)

•(bullet) appearance strongly depends! CTRL+q, % / ALT 0149 CTRL+q, % / ALT 0149

† (dagger) CTRL+q, SPACE CTRL+q, SPACE

‡ (double dagger) CTRL+q, ‘ (grave accent) CTRL+q, ‘ (grave accent)

™ (trade mark) CTRL+q,, * CTRL+q, *

© (copyright) CTRL+q, ) CTRL+q,)

® (registered) CTRL+q, ( CTRL+q, (

¶ (paragraph symbol) CTRL+q, & CTRL+q, &

§ (section symbol) CTRL+q, $ CTRL+q, $

… (ellipsis) CTRL+q, I (uppercase i) CTRL+q, I (uppercase i)

— m-dash CTRL+q, Q / ALT 0151 CTRL+q, Q / ALT 0151

– n-dash CTRL+q, P / ALT 0150 CTRL+q, P / ALT 0150

  m-space ESC, blank, m / SHIFT+CTRL+blank ESC, s, m / SHIFT+CTRL+leerstelle

  n-space (m/2) ESC, blank, n / ALT+CTRL+blank ESC, s, n / ALT+CTRL+leer

 thin space (m/12) ESC, blank, t ESC, s, t

numeric space ESC, ,1 ESC, , 1

  non breaking space (m/3.5) ESC, blank, h / CTRL+blank ESC, s, z / CTRL+leerstelle

nonbreakable hyphen ESC, -, h ESC, -, w 

optional hyphen ESC,-, D / CTRL+minus ESC, -, t / CTRL+minus

suppress hyphenation ESC,n,s (front of word) ESC, k, t (am wort-anfang)

TAB in table cell ESC, TAB ESC, TAB

Select entire table triple click in any cell triple click in any cell

Select table column Double click close to  R/L border of cell Double click close to  R/L border of cell

Select table row Double click in the middle of a cell Double click in the middle of a cell

Add row after current row in table CTRL+RET CTRL+RET

Go to anchor position (behind anchor) ESC, t, SHIFT+i (cursor to be in table) ESC, t, w (cursor in tabelle)
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Special characters in dialogue boxes

Some of the most used special characters can be entered into 
dialogue boxes with a meta notation \xxx (the \ ‘escapes’ 
from the literal meaning of the character). These meta-nota-
tions are independent of the UI language and platform.

Insert variable name a.) ESC, q, v, name, RET 
CTRL+0, name, RET

ESC, k, v, name, RET
CTRL+0, name, RET

Refresh display CTRL+l (lower case L) CTRL+l (lower case L)

Hyperjump from references ALT+CTRL+click on the reference ALT+CTRL+click on the reference

Previous view (goback) in same file ESC, v, P ESC, v, v

Pick up graphic properties ESC, g, O (upper case letter o) ESC, g, O (upper cas letter o)

Lock / unlock document (view / edit) ESC, F, l (lower case L), k ESC, d, Y

Heroic open b) ESC o, H ESC o, H

Open without updating references CTRL+click on the Open button in the Open dialogue

a. Name can be abbreviated to significant length

b. Another (empty) document must be open. This bypasses all sorts of checks to 'force' a file to open. Before 
any changes save the file and reopen it normally.

Purpose English FrameMaker version (Win) Deutsche FrameMaker version (Win)

Desired character Meta notation hex Desired character Meta notation hex

TAB \t \x08 per thousand (‰) \%

forced return \r \x09 guillemet single left (‹) \(

start of paragraph \P guillemet single right (›) \)

end of paragraph \p \0a quote base single (‚) \, (comma)

start of word \< quote base double („) \g

end of word \> quote double left 66 (“) \‘ (grave) \xd2

end of flow / end of table cell \f a) \x0b quote double right 99 (”) \’ (single q.) \xd3

non breaking hyphen \+ quote single (’) \" (double q.) \x27

optional hyphen \- \x04 accent circumflex (ˆ) \@

suppress hyphenation \_ (underscore)\x05 accent grave (`) \{

backslash \\ accent tilde (˜) \~

non breaking space \ (space) \x11 hungarian umlaut (� ) \&

numeric space \s# or \# \x10 registered (®) \xa8

thin space \st or \i \x12 copyright (©) \xa9

n-space \sn or \N \x13 trademark (™) \TM \xaa

m-space \sm or \M \x14 ligature fi \fi only on Mac

n-dash \= \xd0 ligature fl \fl only on Mac

m-dash \m \xd1 micro sign (μ) \u only on Mac

bullet (•) \b \xa5 ligature Œ \OE

dagger (†) \d \xa0 ligature œ \oe

double dagger (‡) \D \xe0 ß (sharp s) \xa7 or ALT+0223

ellipsis (…) \e \xc9 Y-trema (Ÿ) \Y:

florin (ƒ) \F z-caron (ž) \k

fraction, non breaking slash (⁄) \/ (slash)b) \xda Z-caron (Ž) \.

a. \f does not work in Windows, \x0b finds the end-of-flow mark correctly

b. This is taken from the Symbol font, hence does normally not match the body font
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Wildcard-characters for Find dialogue

Use Wildcard must be set ON 

To find a $ or ^ while searching with Wild cards use \$ or \^

Example To find manually numbered paragraphs (start the line with a 
figure, followed by a period and a TAB symbol), use this pat-
tern
^*[0-9].\t

Note: There are no wildcard notations for the replacement text.

Characters with diacritical marks etc.

For platform independence FrameMaker uses a special Inter-
nal code table on page 16 which differs from any standard 
platform code table. Hence various methods must be used to 
get special characters into text or into a dialogue box.

Text entry A rich keyboard (e.g. the Swiss one) gives you direct access to 
all accented characters (except those with ring). These can be 
entered both in text and dialogue boxes.
Characters not on your keyboard you either use an escape 
sequence (3 key strokes) or a CTRL-q sequence (2 keystrokes).

� enter a CTRL+q sequence (if such a sequence is given) to get 
the desired results, or

� enter an esc sequence. For example, to get an å into the 
text, type esc, *, a (three distinct key strokes). This 
method can not be applied in dialogue boxes.

Escape sequences Characters in rows 80 and 90 (of the internal code page) are 
created with esc sequences. For example, to get a Å type ESC, 
*, A (3 key strokes). See Internal code table on page 16.

CTRL-q sequence Characters in rows a0 … f0 (of the internal code page) are cre-
ated with CTRL+q, followed by a character from the ASCII code 
page at a corresponding location (locascii = locfm - 80hex). For 
example, to get a Þ type CTRL+q, W (2 keys).

Entry into dialogue fields For characters not supported by the keyboard neither the 
CTR-q sequence nor the ESC sequences work. You need the 
hexadecimal value of the code point within the FrameMaker 
code. For example, to get an å into the entry field, type \x8c.

Matching Wild-card char.

Any number of characters * (asterisk)

Any one character ?

White space or punctuation | (vertical bar)

Start of line ^

End of line $

any character from list xyz (or alphanu-
meric)

[abcd] or [a-zA-Z0-9]

any character except the listed [^abcd]

brackets \[ and \]

Special characters such as TAB or m-dash See table above
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Symbols and dingbats

Place symbols into text To get a symbol or dingbats, such as ⊄ or j into text): 

1 Use your keyboard to enter the base character (À or à).

2 If not available on the keyboard, use the CTRL-q sequence 
(CTRL-q K) or the ESC sequence (esc ‘ a) 

3 Apply the font property by character format (symbol) or 
font (Webdings).

Note: If you first define the font and then enter a character, you get 
different results, which are not correct.

Place symbol into 
dialogue box

To get a symbol or dingbats, such as ⊄ or j into text): 

1 Use your keyboard to enter the base character (À or à).

2 If not available on the keyboard, use the code notation 
(\xcb or \x88)

3 Define the special font by a character format.

This table contains 217 lines, hence all codes in a Windows 
character set are covered. For an interactive PDF table see 
Microtype 

Symbols from other fonts To insert a symbol which you do not find in the table hereaf-
ter (for example ¬ located in font Wingdings 3:

1 Get the Character Code from the Windows tool Character 
Map and look it up in the Internal code table on page 16.

For example the symbol ¬ has code CA (row C0, column 
0A) representing þ (which you can enter with CTRL+Q, J).

2 Insert the base character þ into the text, then apply a cha-
racter format specifying the font or just apply the font 
(Wingdings 3). ¬ will appear in the text.

More examples:

Note about the following 
table

Although every effort was taken to get a complete and accu-
rate table, the author can not be held responsible for any 
errors. Various sources had to be consulted and MIF had to be 
examined to get as much information as possible.

PostScript font Zapf Dingbats has not been included, because 
the role of PS fonts (T1 type) has dwindled since 2000, when 
TrueType fonts were supported reliable even by Acrobat.

Symbol Font Code Base character

⇪ Wingdings 3 0x59 Y

Ð Wingdings 3 0xEE CTRL+Q, n

 MS Reference Specialty 0x44 D

 MS Reference Specialty 0xCB CTRL+Q, K

http://www.microtype.com/resources/MT_Charset.zip
http://www.microtype.com/resources/MT_Charset.zip


Symbols and dingbats

A – 6

Standard chars

char Ctrl+q 
or esc

\x
(hex)

Symbol D+DD Wing
dings

Wing-
dings2

Web
dings

A 41 Α  $ $ $

a 61 α  H D D

À K cb ⊄  ± ­ ­

à esc ‘ 
a

88   j j j

Á g e7 ⎜  Í É É

á esc ´ 
a

87   i i i

Â e e5 ∑  Ë Ç Ç

â esc ^ 
a

89   k k k

Ã L cc ⊂  ² ® ®

ã esc ~ 
a

8b   m m m

Ä esc : 
A

80   b ☼ b

ä esc : 
a

8a   l l l

Å esc *
A

81   c c c

å esc *
a

8c   $ $ n

Æ . ae →  H D �

æ > be ⎯  ± ­  

b 62 β  I E E

B 42 Β  % % %

C 43 Χ  & & &

c 63 χ  J F F

Ç esc ,
C

82   d d d

ç esc ,
c

8d   o o o

D 44 Δ  ' ' '
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d 64 δ  K G G

Ð C c3 ℘  © ¥ ¥

ð 2 b2 ″  � � �

E 45 Ε  ( ( (

e 65 ε  L H H

È i e9 ⎡  Ï Ë Ë

è esc ‘ 
e

8f   q q q

É esc ´
E

83   e e e

é esc ´
e

8e   p p p

Ê f e6 ⎛  Ì È È

ê esc ^
e

90   r r r

Ë h e8 ⎝  Î Ê Ê

ë esc :
e

91   s s s

F 46 Φ  ) ) )

f 66 φ  M I I

G 47 Γ  * * *

g 67 γ  N J J

H 48 Η  + + +

h 68 η  O K K

I 49 Ι  , , ,

i 69 ι  P 0 L

Ì m ed ⎨  Ó Ï Ï

ì esc ‘
i

93   u u u

Standard chars

char Ctrl+q 
or esc

\x
(hex)

Symbol D+DD Wing
dings

Wing-
dings2

Web
dings
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Í j ea ⎢  Ð Ì Ì

í esc ´
i

92   t t t

Î k eb ⎣  Ñ Í Í

î esc ^
i

94   v v v

Ï l ec ⎧  Ò Î Î

ï esc :
i

95   w w w

J 4a ϑ  ☺ - -

j 6a ϕ  Q 1 M

K 4b Κ  . . .

k 6b κ  R 2 N

L 4c Λ  / / /

l 6c λ  z 3 O

M 4d Μ  0 0 0

m 6d μ  � 4 P

N 4e Ν  1 1 1

n 6e ν  � 5 Q

Ñ esc ~
N

84   f f f

ñ esc ~
n

96   W x x

O 4f Ο  2 2 2

o 6f ο  � 6 R

Ò q f1 〉  × Ó Ó

ò esc ‘
o

98   Y z z

Ó n ee ⎩  Ô Ð Ð

Standard chars

char Ctrl+q 
or esc

\x
(hex)

Symbol D+DD Wing
dings

Wing-
dings2

Web
dings
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ó esc ´
o

97   X y y

Ô o ef ⎪  Õ Ñ Ñ

ô esc ^ 
o

99   Z { {

Õ M cd ⊆  ³ ¯ ¯

õ esc ~ 
o

9b   \ } }

ö esc :
o

9a   [ | |

Ö esc :
O

85   g g g

Œ N ce ∈  ´ ° °

œ O cf ∉  µ ± ±

Ø / af ↓  � � �

ø ? bf ↵  ¥ ¡ ¡

P 50 Π  3 3 3

p 70 π  � 7 S

Q 51 Θ  4 4 4

q 71 θ  � 8 T

R 52 Ρ  5 5 5

r 72 ρ  � 9 U

S 53 Σ  6 6 6

s 73 σ  � V V

ß
’

single 
quote

a7 ♣  � � �

Š 3 b3 ≥  � � �

š p f0   Ö Ò Ò

Standard chars

char Ctrl+q 
or esc

\x
(hex)

Symbol D+DD Wing
dings

Wing-
dings2

Web
dings

Note

On a Swiss (and many other 
European) keyboard the tilde 
is an accent, hence you must 
type a character (e.g. blank) 
after it.

ESC, ~, o creates the same 
as ~, o

Straight single quote

To get the straight single 
quote either «Smart Quotes» 
must be switched off in For-
mat > Document > Text 
Options... or you type
ESC, CTRL+' 
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Þ W d7 ⋅  ½ ¹ ¸

þ J ca ⊇  ° ¬ ¬

T 54 Τ  7 7 7

t 74 τ  � W W

U 55 Υ  < 8 8

u 75 υ  � X X

Ù t f4 ⎮  Ú Ö Ö

ù esc ‘
u

9d   ^ � �

Ú r f2 ∫  Ø Ô Ô

ú esc ´
u

9c   ] ~ ~

Û s f3 ⌠  Ù Õ Õ

û esc ^
u

9e   x � �

Ü esc :
U

86   h h h

ü esc :
u

9f   y � �

V 56 ς  = 9 9

v 76 ϖ  � Y Y

W 57 Ω  > : :

w 77 ω  � Z Z

X 58 Ξ  ? ; ;

x 78 ξ  ⌧ [ [

Y 59 Ψ  @ < <

y 79 ψ  ` \ \

Ý E c5 ⊕  « § §

Standard chars

char Ctrl+q 
or esc

\x
(hex)

Symbol D+DD Wing
dings

Wing-
dings2

Web
dings
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ý F c6 ∅  ¬ ¨ ¨

Ÿ Y d9 ∧  ¿ » º

ÿ X d8 ¬  ¾ º ¹

Z 5a Ζ  A = =

z 7a ζ  a ] ]

Ž z fa ⎥  à � Ü

ž ~ fe ⎭  ; � à

0 30 0  � � �

1 31 1  � � �

2 32 2  � � �

3 33 3  � � �

4 34 4  � � �

5 35 5  � � �

6 36 6  � � �

7 37 7  � � �

8 38 8  � � �

9 39 9  � � �

! 21 !  � � �

" esc " 22 ∀  � � �

# 23 #  � � �

$ 24 ∃  � � �

% 25 %  � � �

& 26 &  	 	 	

Standard chars

char Ctrl+q 
or esc

\x
(hex)

Symbol D+DD Wing
dings

Wing-
dings2

Web
dings

Straight double quote

To get the straight double 
quote either «Smart Quotes» 
must be switched off in For-
mat > Document > Text 
Options... or you type ESC, "
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'
ctrl+

single 
quote

27
\q ∋  
 ℡ 


( 28 (  � � �

) 29 )  � � �

* 2a ∗  
 
 


+ 2b +  � � �

, 2c ,  � � �

- 2d −  � � �

. 2e .  � � �

/ 2f /  � � /

: 3a :  � � �

; 3b ;  � � �

< 3c <  � � �

= 3d =     

> 3e >  ! ! !

? 3f ?  " " "

@ 40 ≅  # # #

[ 5b [  ☯ > >

\ 5c
\\ ∴  C ? \

] 5d ]  D @ @

^ 5e ⊥  E A A

_ 5f _  F B B

`
grave

60
\Q ⎯  G C C

Standard chars

char Ctrl+q 
or esc

\x
(hex)

Symbol D+DD Wing
dings

Wing-
dings2

Web
dings

Straight single quote

To get the straight single 
quote either «Smart Quotes» 
must be switched off in For-
mat > Document > Text 
Options... or you type
ESC, CTRL+' 

Grave

On a Swiss keyboard (and 
other European) this is an 
accent. Nevertheless you can 
not create it like a tilde.

CTRL+Q, CTRL+'creates `
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{ 7b {  U ^ ^

| 7c |  V _ |

} 7d }  S ` `

~ 7e ∼  T a a

· a e1 〈  Ç Ã Ã

¡ A c1 ℑ  § £ £

¿ @ c0 ℵ  ¦ ¢ ¢

£ # a3 ≤  } � �

¥ 4 b4 ×  � � �

ƒ D c4 ⊗  ª ¦ ¦

¢ " a2 ′  | � �

¤ [ db ⇔  Á ½ ¼

® ( a8 ♦  � � �

© ) a9 ♥  � � �

™ * aa ♠  � � �

¼ 9 b9 ≠  � � �

½ : ba ≡    � �

¾ = bd ⏐  £ � �

ª ; bb ≈  ¡ � �

º < bc …  ¢ � �

± 1 b1 ±  � � �

× 0 b0 °  � � �

÷ V d6 √  ⌦ ¸ ·

Standard chars

char Ctrl+q 
or esc

\x
(hex)

Symbol D+DD Wing
dings

Wing-
dings2

Web
dings

Vertical bar

On a Swiss keyboard the key ¦ 
(ALTGR+7) must be used!

Example

To get an Aleph symbol (ℵ) 
into the text, enter CTRL+q, @ 
(two key strokes) and apply 
to the appearing ¿ a charac-
ter format which provides 
the Symbol font.
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⁄ Z da ∨  À ¼ »

μ 5 b5 ∝  � � �

¶ & a6 ƒ  � � �

§ $ a4 ⁄  ~ � �

† blank
a0
\d   � � ½

¬ B c2 ℜ  ¨ ¤ ¤

‰ d e4 ™  Ê Æ Æ

¹ 6 b6 ∂  � � �

² 7 b7 •  � � �

³ 8 b8 ÷  � � �

¦ - ad ↑  � � �

° ! a1 ϒ  { � ´

• % a5 ∞  � � �

– P d0 ∠  ¶ ² ²

— Q d1 ∇  · ³ ³

… I c9 ⊃  ¯ « «

¯ x f8 ⎠  Þ Ú Ú

ˆ v f6 ⎞  Ü Ø Ø

˜ w f7 ⎟  Ý Ù Ù

´ + ab ↔  � � �

¨ , ac ←  � � �

° { fb ⎦  8 � Ý

t́ } fd
\& ⎬  : � ß

Standard chars

char Ctrl+q 
or esc

\x
(hex)

Symbol D+DD Wing
dings

Wing-
dings2

Web
dings

Broken vertical bar

On a Swiss keyboard the key | 
(ALTGR+1) must be used!
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Example To enter the 9symbol in text, type the | character and apply 
a character format which defines the font Wingdings

To get a list ‘numbered’ with the 9symbol, enter the 
sequence \xfc into the numbering field and apply a character 
format which defines the font Wingdings.

“ R d2 ®  ¸ ´ �

” S d3 ©  ¹ µ �

‘ T d4 ™  º ¶ µ

’ U d5 ∏  ⌫ · ¶

„ c e3 ©  É Å Å

‚ b e2 ®  È Ä Ä

‡ acc. 
grave

e0
\D ◊  Æ Â Â

¸ | fc ⎫  9 � Þ

‹ \ dc ⇐  Â ¾ ¾

› ] dd ⇑  Ã ¿ ¿

« G c7 ∩  ­ © ©

» H c8 ∪  ® ª ª

Standard chars

char Ctrl+q 
or esc

\x
(hex)

Symbol D+DD Wing
dings

Wing-
dings2

Web
dings

Double dagger

On a Swiss keyboard the 
grave character can not be 
entered directly into FM. A 
CTRL-Q sequence is needed:

CTRL+Q, ` creates ‡ You 
type the ` as ALTGR+`

Vertical bar (solid)

On a Swiss keyboard the bro-
ken vertical must be used 
(ALTGR+7).
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Internal code table 

The small character (sequences) below a row indicate the reference 
characters needed in ESC sequence or the CTRL-q sequence (see note). 

Use one of these methods for characters not on the keyboard:

Escape sequences Characters in rows 80 and 90 are created with esc sequences, 
e.g. to get a Å type ESC, *, A (3 key strokes).

CTRL-q sequence Characters in rows a0 … f0 are created by CTRL+q, followed by 
a character from the ASCII code page at a resp. location 
(locascii = locfm - 80hex); e.g. to get a Þ type CTRL+q, W (2 keys).

Characters require FrameMaker 7.2p158 and Win CE font.

These characters are available only on the Mac.

00 01 02 03 04 05 06 07 08 09 0a 0b 0c 0d 0e 0f

00
descr. 
hyph

suppr 
hyph

TAB NL
para 
end

flow 
end

10
num 

space
nonbr 
space

thin 
space

en 
space

em 
space

nonbr 
hyph

20 blank ! " # $ % & ’ ( ) * + , - . /
30 0 1 2 3 4 5 6 7 8 9 : ; < = > ?
40 @ A B C D E F G H I J K L M N O
50 P Q R S T U V W X Y Z [ \ ] ^ _
60 ‘ a b c d e f g h i j k l m n o
70 p q r s t u v w x y z { | } ~ DEL

80
Ä Å Ç É Ñ Ö Ü á à â ä ã å ç é è
: A * A , C ’ E ~ N : O : U ’ a ‘ a ^ a : a ~ a * a , c ’ e ‘ e

90
ê ë í ì î ï ñ ó ò ô ö õ ú ù û ü
^ e : e ’ i ‘ i ^ i : i ~ n ’ o ‘ o ^ o : o ~ o ’ u ‘ u ^ u : u

a0
† ° ¢ £ § • ¶ ß ® © ™ ´ ¨ ¦ Æ Ø

blank ! " # $ % & ’ ( ) * + , - . /

b0
× ± ð Š ¥ μ ¹ ² ³ ¼ ½ ª º ¾ æ ø
0 1 2 3 4 5 6 7 8 9 : ; < = > ?

c0
¿ ¡ ¬ Ð ƒ Ý ý « » … þ À Ã Õ Œ œ
@ A B C D E F G H I J K L M N O

d0
– — “ ” ‘ ’ ÷ Þ ÿ Ÿ ⁄ ¤ ‹ › Ź ff
P Q R S T U V W X Y Z [ \ ] ^ _

e0
‡ · ‚ „ ‰ Â Ê Á Ë È Í Î Ï Ì Ó Ô

‘ a b c d e f g h i j k l m n o

f0
š Ò Ú Û Ù € circum

flex
tilde macron breve Ž ring cedilla t’ ž undef

p q r s t u v w x y z { | } ~
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Note: Characters CTRL-q v … } are accents. For example CTRL-q v (ˆ) 
and ^ are different characters. The code table is based on Mac-
Roman.

Non-width characters

With View > Text Symbols active FrameMaker displays spe-
cial symbols such as anchors, optional hyphens etc. This dis-
play must not disturb the layout – hence these characters 
have no width.

No width characters can be stacked at a place – for example, 
anchoring several tables at the same place. This makes it very 
difficult, to select a distinct element, which is either the spe-
cial character itself (e.g. optional hyphen) or the anchored 
item. Even with 500% zoom factor you can not grab an indi-
vidual anchor.

Select a non-width 
character (or narrow 
characters)

1 Place the cursor behind the last recognisable character or 
the end of the paragraph (as in this diagram)

2 With the arrow left key move through the characters (in 
this case, before the closing parenthesis)

3 Hold down shift key while moving with the arrow left key 
over the anchor. This «extends the selection» (GUI term).

4 The anchored object becomes selected also. So you know, 
whether you have selected the right stuff...

If you didn’t catch the right thing, release the shift key, move 
back one character (in our case with the arrow right key) and 
repeat step 3 for any anchor which may be present left to the 
already found one.

Of course you can apply this procedure also from left to right.

This is any text with an anchor 
for the following table just here 
( )

TT ...(
T

)§
123 T

)§...(
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FrameMaker set up

General preferences

With File > Preferences > General you set the most used 
preferences:

Saving a file in FrameMaker does not take much time. Even for 
large files (200 pages) it is possible to automatically save 
every 10 minutes without significant delay of the work.

Automatic backup creates a backup file whenever you open 
the file. This file is over written at the next open. If you want 
to preserve versions, you need to rename the backups.

Sharing files in a network requires the option Network File 
Locking to be set. FrameMaker will create a file document.lck 
which existence is checked at open to prevent an additional 
open by an other user.

After selecting a different Product Interface (standard Fram-
eMaker or Structured FrameMaker) you need to restart the 
program.

Since FM 7.2 the warnings about clearing the Undo History 
can be specified.

Be aware of unavailable 
fonts

In the preferences dialogue you can set Remember Missing 
Font Names. Always set this option when you receive docu-
ments from other platforms.

Set this option also, if you receive a document for revision 
and need to give it back again. The font situation differs on 
most systems - even with the same operating system!

If a document contains fonts which are not available on the 
Windows platform and this option is not set then all unknown 
fonts are replaced by Times Roman and the information con-
cerning the original fonts used is lost.

Units of measure

When entering just a numeric value into an entry field in a 
dialogue, FrameMaker uses the default unit (which depends 
on purpose). Hence for clarity always enter also the unit.

www.cl.cam.ac.uk states:

The length of an inch 
changed from 1/0.3937 cm 
to 2.54 cm in 1959; the size 
of a point did not. Conse-
quently, the imperial 'size' of 
a point changed from 1/72 
inch to 1/72.27 inch. [Knuth 
1984, The TEXbook, p. 58]

DTP point = PostScript point. 
1 ATA pt (American Typefounders 
Association) = 0.013837". 
1 TEX pt = 1/72.27"

Unit Enter into 
dialogue

metric
Equivalent

Imperial 
equivalent

Definition

cm cm 10 mm 03937. inch

mm mm 0.1 cm 0.03937 inch

inch in, " 2.54 cm 1 inch USA, UK

pica pc, pi, pica 4.2175176 mm 1/6 inch 12 points (ATA)

DTP point pt, point 0.35278 mm 1/72 = 0.0139 " 1/72 US inch

Didot point dd 0.376 mm 1.07 pt 1/72 French inch

Cicero cc, cicero 4.531 mm 12.84 pt 12 Didot point

http://www.cl.cam.ac.uk/~mgk25/metric-typo/
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Platform specifics

Macintosh system 9

Windows handling

Quick access bar The quick access bar (button bar) is part of the document 
interface and hence only available with an open document

Palettes and non-modal
windows

Palettes (¶-catalogue, graphic tools etc.) and non-modal win-
dows (Find/Replace etc.) are not automatically kept on top of 
the displayed windows. To avoid frequent re-calling them, 
either install an appropriate system extension or reduce the 
document window width to allow grabbing the ancillary win-
dows at the right of the document window.

Keyboard input All entries using ESC sequences and CTR+q sequences are 
also valid on the Macintosh. The keyboard short cut using the 
modifier keys are different to those on Windows:

Operations and
typographic characters

Style name can be abbreviated to significant length

Special characters Some of these you might have forgotten how to type:

Appearance of check 
boxes

The «As Is» state occurs, if some of the selected items have 
set properties and some have not set (cleared) properties.

Key Meaning Key Meaning

 Shift  Option, sometimes called Alt

 Control  Command

Purpose Short cut Purpose Short cut

Format paragraph +9 — m-dash ++minus

Format characters +8 – n-dash +minus

Open Paragraph designer ++m n n m-space ++9

Open Character designer ++d n n n-space (m/2) ++8

Open Table designer ++t nn thin space (m/12) ++7

Repeat last character 
modification

+C numeric space ++0

Repeat last paragraph 
modification

+A n n non breaking space 
(m/3.5)

+blank

Straight single quote +’ optional hyphen +minus

Straight double quote +» suppress hyphenation ++minus

Refresh display +l (lower 
case L)

char keys char keys char keys

[ +5 ] +6 \ ++7

{ +8 } +9 @ +g

' +' " ++' # +3

checked
(active)

unchecked
(inactive)

As Is
(may be)

Appearance in Mac 
OS 9
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Unix (Sun Solaris)

Window handling Quick access bar, palettes and all non-modal windows are dis-
tinct windows and are not ‘integrated’ into the document win-
dow. For easy access reduce the document window width to 
allow grabbing the ancillary windows at the right of the docu-
ment window.

Appearance of check 
boxes

The «As Is» state occurs, if some of the selected items have 
set properties and some have not set (cleared) properties.

Keyboard specials The following relates to a Swiss-German keyboard only. I do 
not have experience with other keyboards on Sun Solaris.

� There is no forward delete (deleting character to the right 
of the cursor) only the Backspace function exists.

� A common keyboard layout includes function keys to the 
left of the typewriter layout:

Sole accents These can not be entered by using the compose + accent key 
followed by a blank (as on Windows and Mac). This method 
allows only to construct accented characters from the ISO 
Latin 1 set (e.g. ã ñ). To create accent characters of their own, 
do the following:

Tilde press ALTGR + 5

Circumflex press ALTGR + 4

Grave press ALTGR + 0 11)

Aigu press ALTGR + ? (key right to the 0)

Closing bracket The character ] can not be entered from the keyboard. It 
needs to be created in a text editor and then pasted to FM.

Degree symbol The degree symbol is very unruly when entered with the top 
left key. In some fonts it does not show up; in others it 
appears an infinity symbol (∞). When entered into a dialogue 
field it results in \xb0. Using CTRL+Q, ! results in \xb1. You 
need to copy this symbol from a text editor or Word …

checked
(active)

unchecked
(inactive)

As Is
(may be)

UNIX Solaris KDE

11 On the systems I had available this created an aigu accent (´) in text, but 
a correct grave accent (‘) in dialogue fields.
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Copy and paste To handle all situations (including copy/paste from other 
applications), different methods are necessary.

Within FrameMaker text The left key group contains Again, Undo, Copy, Paste and 
Cut. Within FrameMaker these keys must be used – if you do 
not like to use the ESC sequences (for example ESC, e, c for 
copy) or menu entries.

This method can not be used to transfer data from the docu-
ment into a dialogue field.

Into FrameMaker
dialogues and

across applications

To transfer data from the FM document text into a FM dia-
logue field the X-windows buffer must be used. The same is 
true for transferring data between FM and another applica-
tions.

The X-buffer is automatically filled if text is selected. It is 
pasted into a new location by the middle mouse button:

1 Select the text to be copied with the left mouse. Get a word 
including the trailing space by double click or a paragraph 
by triple click.

2 Paste the buffer contents at the new location by placing the 
cursor and middle click.

Hyperlinks Hypertext (e.g. a cross-reference) is activated by CTRL-right-
click. Under some circumstances (e.g. X-Window client is an 
emulation on Windows) an additional read-only document is 
created and jumped into this.

In case of URLs (web link, e-mail) nothing may happen, 
because no connection to a browser or e-mail client may be 
established.

Keyboard macros Unix allows to create keyboard macros via menu File > Utili-
ties > Macro. It is good practice to invoke macros with a spe-
cial key such as the meta key (�), located on both sides of 
the space bar:

For example, to open the ¶ designer: press � + F5. Or to copy 
a paragraph format press � + 0.

Code of macro Copy
Paragraph Format

Copy para format (meta null):
   <Macro Macro10
       <Label Macro10>
       <Trigger ~0>
       <TriggerLabel ~0>
       <Definition \!bf>
       <Mode NonMath>>

Macros can not contain symbolic entries. It is quite difficult 
also to handle dialog input.

Macros can not … y Wait for keyboard input in a dialogue and then continue 
the macro. You will need to set up two macros.

y Record mouse actions

y Record F10 (put focus on menu bar)

y Record F4 (display context menu)

u...
kein seiten- spalten- Masterpage  

zuordnung
¶ f T default f  

format
e-mail URL

Umbruch Designer Hyperlinks

Set Zoom ä 95% ä 180% Camera highl. marker Copy ¶ fmt
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Macro with
dialogue input

1 Start recording. Use only keyboard input for the actions to 
be recorded.

2 When at the dialogue, press CTRL+TAB to get to the first 
entry. This start is essential.

3 Enter the first value in the first field and jump to the next 
field with TAB or SHIFT+TAB to jump back.

4 Fill all fields, also those which already contain the desired 
values. Use the UP/DOWN arrow keys to navigate in scroll 
lists.

5 Enter RETURN to close the dialogue and get the values

6 Stop the macro and save it with appropriate name and trig-
ger.

Stop macro at
dialogue 12)

To create a macro which stops at a dialogue to enter values 
manually, enter CTRL+] when the dialogue appears in the 
recording. Then save the macro.

In the running macro (which stops at the open dialogue) enter 
the values, then press CTRL+].

Macro with repeated
actions

1 Record the actions to be repeated in a macro A

2 Set up a second macro B, in which macro A is invoked as 
often as necessary.

Location of macros Macros are located in a text file in the current account, for 
example at /home/afs99/fmMacros. The name must be 
fmMacros.

12 Procedure not rally clear - need to verify at LuStat
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Solving real and assumed problems
See also hints and tips on the web: www.daube.ch/docu/
fmaker00.html

Method to find the cause 
of problems

The general method to encircle problems is to bisect the doc-
ument and check each halve.

By further narrowing down to one page and then to para-
graphs, tables, graphics etc. you can find the culprit.

General problems

Warning: only one Undo 
level until version 7.1

Until version 7.1 FrameMaker has only one undo level. Hence 
save the file before you start any experiments or are not cer-
tain about the usefulness of a specific manipulation! From my 
long lasting experience with FrameMaker I can tell You that 
there is no reason to bemoan this situation. After some time 
of familiarity with FrameMaker You don’t need much undo.

Since version 7.2 FrameMaker provides multiple undo. How-
ever there are still operations which can not be undone and 
which therefore clear the undo-history. See this Adobe document 
for details of the function.

Strange behaviour of 
document

There are situations where FrameMaker seems to have lost all 
its ‘sense’. What’s going on?

FrameMaker relies on the Windows system services for stor-
age management, and these are not very water tight. Hence 
you may get situations which are the result of lost pointers or 
other garbage in storage.

Most of these situations can be fixed with the following:

� Save the file in MIF

� Close the document (do not save it)

� Open the MIF file

� Save the file again as FrameMaker (you may wish to use a 
different name to the original one).

In most cases the file now behaves ‘normal’ again.

Can not copy/paste text Text selected from a text line (produced with graphic tool A) 
can be copied to the clipboard, however:

� it can only be pasted into a text frame (like this one);

� it can not be pasted into dialogue boxes;

� it can not be pasted into another application.

Find does not find You may need to switch to the masterpages or the reference 
pages to find the requested item. You can not search within 
text inserts - they are independent files.

See also Can not find words on page A-27

http://www.daube.ch/docu/fmaker00.html
http://www.daube.ch/docu/fmaker00.html
http://www.adobe.com/support/techdocs/331774.html
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Display and layout issues

Display jumps back when 
scrolling

This is a known bug since version 4 at least. The problem is 
caused by graphics with property «run around» which 
touches or overlaps a text frame (which may be on a master 
page).

Solution according to
Adobe KNB document

322405

1 FrameMaker 6.0 should have cleared this problem.

2 Locate the graphic that triggers the jump and

Adjust the adjacent text frame to remove the overlap / 
touching; or remove the run-around property from the 
graphic (if applicable).

3 Terminate the behaviour for the current FM session:

- Click outside any text frame and scroll through the com-
plete document.

- After any close / re-open or File > Revert to Save, this 
procedure must be repeated.

General solution Install the free plug-in RunaroundNone 
(www.frameexpert.com)

EPS looks awful on 
screen

An eps may contain a preview image, which is displayed on 
the screen. The resolution of this preview image can be set in 
most graphic applications. If not, a default of 72 dpi (dots to 
the inch) is used. Compare the two screen images:

If you need to position graphic elements (arrows, pointers) 
precisely or to get an idea of small print on an imported eps, 
you need to create it with a good preview picture. Just zoom-
ing into the image in FrameMaker does not do the job.

EPS prints, but on screen 
is only gray area

The cause is trivial: the eps does not contain a preview image. 
If you need to overlay some information on such an image, 
you do not have a clue where to place things. Hence you need 
to recreate the eps with a preview image.

If the source image and/or application not available, these 
steps may help you:

1 Print the page with the image to a PostScript file

2 Make a PDF from the page using Acrobat Distiller

3 Crop the page in Acrobat to the size of the image and 
export as eps with preview.

4 Import the eps to FrameMaker

72 dpi preview

300 dpi preview

http://www.frameexpert.com/
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Destroyed file contents? After some work (e.g. delete rows in tables, heavy editing of 
text) your screen may look very strange:

� line thicknesses are wrong

� lines are lost

� text lines are intermingled

� graphics are incomplete

� etc.

Don’t panic, force a screen refresh either with CTRL+l (lower 
case L) or PageUp, then PageDown or other scrolling and do 
not forget to enlarge the image (the line may simply ‘fall 
between the pixels’ as in the depicted case).

Text can not be selected

You can not select text, as long as the cursor has the shape of 
a hollow arrow. Wherever you click with this cursor, the 
object (text frame) is selected (you see the handles of the 
object) - not the contents (the text).

Check the tools palette for the cursor setting. It will look as 
displayed in the image. 

You must select the ‘intelligent’ type of cursor (left button 
with the two cursor shapes on it).

Line not
visible

Artefact of
re-formatting
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Ghost objects

Real duplicates You can access any object (e.g. a text frame) with CTRL+click. 
But you create a duplicate with CTRL+drag...

The current (selected) object is the duplicate which you can 
delete. It is also possible to undo the duplication operation.

Additional table
headers

Another type of ghost object is an additional table header on 
subsequent table pages

Try to cure this
situation by

� Switching to the master pages, to look whether there is 
something wrong.

� Switching back to the body pages with Remove Overrides 
activated.

Concealed objects Sometimes you can just see the black handles during the 
build-up of the screen. They are invisible when the screen is 
complete

If you suspect invisible
objects,

� Start a selection rectangle outside the text frame and sweep 
the suspected area.

� This will select the hidden objects (if there are any).

� Bring them to the foreground with Graphics > Bring to 
Front

The original heading row Original heading row

This is something you can not get rid of, but you can not select it!

The first table cell the second table cell

and the next table cell the fourth table cell

the last line in the table the last cell in the table

Cursor opening the selection area

text
frame
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Where is the text? You have just imported a large text into a text frame, but the 
frame does not contain all the text.

A thin solid line at the bottom of the text frame indicates that 
there is more text then the frame can hold.

Enlarge the text frame or arrange for a connected text frame 
with the same text flow name.

Can not see facing pages You have reduced the zoom factor to a value with which 
pages could be arrange face to face (for example, to check the 
layout), but they do not:

The view of a document is saved in the file, hence you can 
have a different view on each open document. 

In View > Options… select Variable for Page Scrolling to get 
the display of facing pages.

Can not find words Searching for a sequence of words may not yield any result, if 
the text is interspersed with markers. In this example, the 
search reports ‘not found’:

What you see

This is, what you want to 
see.

You may need a low zoom 
factor if rotated pages are 
in the document.
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To avoid such situations:

� Place cross reference markers at the beginning of a para-
graph.

� Insert index markers at the end of a paragraph and com-
bine multiple entries into one marker.

Optional (discretionary) 
hyphen not working

You may see ample space at the end of a line and try to split 
the first word in the next line – but the word is not hyphen-
ated…

You have just hit a WYSIWYG problem: with standard installa-
tion FrameMaker displays fonts with font metrics for opti-
mised presentation of shape – but what we need is optimised 
placement similar to the placement of text in the printed 
page. See Display character positions correctly on page 36 for a 
suggestion.

Right tab not working When setting up text frames the inside text may not behave as 
expected. For example, a right tab might not be executed:

Reason Watch out for a graphic close to the text frame. The graphic 
may have the (default) run-around property „Run around Con-
tour« with a gap value > 0.

As soon as this kind of graphic is closer to the text frame 
than the gap value (or the graphic overlaps the text frame), 
the graphic will push text away.

Correction Remove any overlap or influence of the graphic by

� placing the graphic far away from the text frame (distance 
> gap value), or 

� setting the run-around property of the graphic to „Don’t 
run around«, or

� Allowing „Run around Contour«, but setting the gap value 
to zero.

DisplayUsingPrinterMetrics=Off DisplayUsingPrinterMetrics=On

logo or other graphic too close to text frame

right tab position not reached in text frame
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Table does not split at 
desired row

A table can not split automatically at a certain row, if

� vertically straddled cells hold rows together. Look at all 
columns to find overlaps of vertically straddles cells.

� the table attribute «start on next page» forces a table start.

� the attribute «float» keeps the first page together

� Rows are kept together with «keep with next» or «keep 
with previous».

Example for vertically
straddled cells

The bordered frame is the text frame simulating 2 pages con-
taining the table

Table width and columns 
widths are wrong

Some of the FrameMaker dialogues provide too short entry 
fields. Table > Resize Columns may not display all figures in 
an entry field. Only the right most figures are displayed!

To select a value, do not sweep with the mouse over the figures - 
you might not get all the figures! Instead, double click on the 
figures to select all of them - also the hidden ones.

The real value of the
selected figures may be

318.0 cm

For a solution of this
problem see http://

www.daube.ch/public_html/
docu/fmaker20.html and

fmaker36.html

Watch the vertically straddled 
cells which block table rows.

The heading of the table

Vertically 
straddled 
cells

Vertically 
straddled 
cells over-
lap those 
in column 
2

The heading of the table

page x page x+1

http://www.daube.ch/public_html/docu/fmaker20.html
http://www.daube.ch/public_html/docu/fmaker20.html
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Importing and graphics

Problems with imported 
graphics

Vendors of graphic software tend to modify ‘standard’ output 
formats, which are needed to exchange graphics between 
applications (DXF, EPS, TIFF, WMF, etc.).

If you encounter problems with a FrameMaker document after 
importing a graphic, at first blame the graphic or its creating 
application. To fix the problem:

� Import the graphic to another application - does it create 
problems also there?

� Try to get another version of the graphic.

Imported graphic is not 
visible

If you import a graphic and it is not visible in the container 
(page, anchored frame, graphic frame), you may just see a 
white portion of it:

1 Select the container frame and with CTRL+a select all its 
contents. You will not see the object handles inside the 
now unselected container.

2 If there is really no graphic in the container, all graphic 
menu items (or buttons) are greyed out. You will re-import 
the graphic.

3 Group the invisible selection just in case more than one 
object is in the container.

4 Scale this contents down very much and Align Tops and L/
R Centers it in the container.

5 Now you should see the complete graphic, at least very 
small. Grab a corner handle and enlarge the graphic to the 
size of the container:

6 Now you may see what (might have) happened:

In most cases a small object is included in the complete 
graphic – especially if an eps was created from a CAD drawing 
not all surrounding stuff might have been removed.

The small objects may even be far out of the paper on the 
pasteboard of the drawing application (e.g. Illustrator). To 
avoid this error, you should not select all before creating 
the eps, but select only the desired items and then create the 
eps.

The graphic you are looking for

What is this ?

At import this area was visible
The size of the imported object
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Colour issues

Inconsistent colour One of the most pertinent errors is the inconsistent definition 
of colour in files. You can not get rid of this without major 
work:

Import colour from
correct document

1 Open a document from which you know that the colours 
are OK

2 Open the document with incorrect colour definitions.

3 Import only the colour definitions (File > Import > For-
mats…) from the clean source document.

4 This import is cumulative, that is, special colours in the 
target document are not removed.

5 If the problem persists when updating the book with the 
file in question, an imported graphic may be the culprit. 

Start with an empty
document

1 Set up an empty file with File > New > Document > Por-
trait

2 Delete all entries in the catalogues (paragraph, character), 
the table designer, the cross-reference formats.

3 Import the desired formats from the file with the colour 
error - but do not import the colour specifications!

4 If you really have a special colour set up, do it again.

5 Select the text in the file with the error and paste it into the 
new file. You may use Select All (CTRL+A) to get every-
thing.

Note: In many cases, however, this method import the error with the 
selected text (and graphics included etc.)

Just live the annoyance Ignoring the problem is only possible if you do not intend to 
take this document to a commercial printer!

Imported graphics Imported graphics can be the source of invalid colour defini-
tions. To find the graphic which causes the problem,

� Remove one by one of the graphics and check for the prob-
lem. As soon the problem disappears, you have found the 
graphic in error.

� The colour definition in the erroneous graphic can only be 
handled in the application in which the graphic was cre-
ated.

� If the problematic graphic is an eps (Encapsulated Post-
Script), a TIFF or JPEG the original application can not be 
determined by the graphic type. Only Your intelligence can 
help here …

Huge number of colours You may notice a huge number of colours in your colour cata-
logue after importing graphics of format png (portable net-
work graphic). These colours are named RGB nnn,nnn,nnn. 
You should not delete these, but also not apply to any 
objects, since these colours may get lost when the file is 
saved as MIF (see www.microtype.com).

Note: You get these colours only for 256-colour (8-bit) PNG files. 
Hence use also for screen dumps PNG with ’millions of colours’.

http://www.microtype.com/resources/bugs/Colors_Lost_in_MIF.html
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Font issues

Font xxx missing See also Be aware of unavailable fonts on page 18

When opening a file, the following error message may occur:

Document named abc uses unavailable fonts.
To reformat the document using available fonts, click OK

In the FrameMaker console window you see what has been 
found and substituted:

The "Gugus" Font is not available.
"Times-Roman" will be used in this session.

Note: If you can not get rid of the unavailable font by these meas-
ures, the font may be used in an imported graphic or an empty 
document. See hereafter for methods to find these occurrences.

Where is the unavailable 
font used?

Make a copy of your document before you start your research!

� Use the Edit > Find/Change dialogue to search for a Char-
acter Format. In the character definitions dialogue set all 
but the font family name to as is.
Search the body pages, the master pages and the reference 
pages for the font and correct any use of it.

� The font in question may be used in imported graphics 
(also in an eps). You need the original application to 
change the font. In an eps file you can at least search with 
an ordinary text editor - but do not modify the font name 
just in the editor! Recreate the eps file in case.

� The font in question may be used in empty text lines of 
FrameMaker graphics. Text lines are created with the A-
tool. To find these, 
do for each anchored frame with a graphic:

- Select the anchored frame, then select all objects with 
CTRL+A.

- If you get grouped objects, ungroup them until ungroup 
is not possible anymore.

- Check for empty objects and deselect them by holding 
the shift-key while you click on such an object.

- Group everything which is left selected

Situation Action 

The unknown fonts are important and they must not be substituted per-
manently by the FrameMaker default Times.

Cancel

Activate File > Preferences > Remember missing Font 
names. Now open the file again (you get the same message).

OK

The unavailable font is not essential or just a variation of Times. OK

Whether the substitution is permanent or just in this session, depend on 
the setting of File > Preferences > Remember missing Font 
names

You want to get rid of the unavailable fonts in the document Cancel

Activate File > Preferences > Remember missing Font 
names. Now open the file again (you get the same message).

OK

Save the file; Deactivate File > Preferences > Remember 
missing Font names
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- Select all again, deselect the grouped object. Only the 
empty objects are selected now. Delete them.

Note: A FrameScript script is available from Carmen Publishing for 
deleting empty graphic lines. This requires FrameScript form 
Finite Matters to be installed in your FrameMaker. See Exten-
sions by API clients on page 1-15 for these resources.
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Printing and presentation issues

Misalignment between 
text and graphics

Sometimes graphic elements are needed as an overlay to the 
text on the page (The U shaped line in the example below).

To place the graphic correctly you will use a large zoom level. 
However, the printed version may still be different and not 
accurate.

To avoid this effect, change the maker.ini file according to 
Display character positions correctly on page 36.

Accents not displayed in 
running header

Reason The running header is overlapped by another graphic element 
– in this case with the top text frame of the first header line. 
In the figure below the text frames are visualised with a bor-
der. 

Correction Remove the overlap of the text frame, for example by replac-
ing the two text frames by one of proper height containing 
both header lines. The separating line must be moved to front.

EPS prints badly If an eps looks pixeled (check with slanted lines) in the 
printed output, the reason might be:

� inadequate printer driver (or wrong PPD for PS-printer)

� non-PostScript printer

Messsystem Promag 53 (Kompakt-Ausführung)

Promag 53***-***********x
G = Foundation Fielbus, EEx i
K = Foundation Fielbus

top of frame 1

bottom of frame 2

overlap

line
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Recommended modifications to FM

Set reasonable default for your work

Zoom factors To get reasonable zoom factors in your session, adapt the 
zoom factors to the screen size and resolution. The following 
is for an 20" display. In section [Preferences] 

set to Zoom=28, 36, 50, 74, 90, 125, 200, 353, 500, 1000

When zoomed to 353% a nudge (moving an object by 
ALT+arrow key or ) moves by 0.1mm steps 13).

Dash patterns The following setting provide finer patterns than the FM 
default settings. In section [DashPatterns] 

set 1=Dash, 8, 4
2=Hidden, 4
3=Longdash, 16, 8
4=Dot, 2, 4
5=Dash-Dot, 8, 4, 2, 4
6=Dash-Dot-Dot, 8, 4, 2, 4, 2, 4
7=Chain, 8, 4, 4, 4
8=Phantom, 20, 4, 4, 4, 4, 4

Line widths The default line widths for graphics are rather coarse. In the 
section [Preferences] 

set (for example) to PenWidths=0.28pt, 0.7pt, 1pt, 1.4pt

or (will display as values converted to pt)

PenWidths=0.1mm, 0.25mm, 0.35mm, 0.5mm

Snap and grid Be aware, that some of these settings from the section 
[Preferences] are overridden by document settings.

Snap=On
Gravity=Off
DefaultRulerCm=0.1cm
DefaultGridCm=1cm
DefaultSnapCm=0.1cm

Template path If you want to get document templates from a special loca-
tion, change in section [Directories] 

from TemplateDir=templates
Templatesr=templates

to (for example) TemplateDir=D:\_doc-std\Frame
Templates=D:\_DOC-STD\Frame\FM-templates

Smart quotes Depending on the main language of your document you 
should define the proper typographic quotes in section 
[Spelling]. Select the appropriate set from the comment 
block:

; Deutsche anführungszeichen
SmartQuotes=\xe2\xd4\xe3\xd2

13 A nudge is defined as 1pt at zoom factor 100. Hence a factor of 253 nudg-
es by 0.1mm (1 pt = 25.4mm/72 = 0.3527 mm)
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Note: After installation of FrameMaker14) the definition of French 
quotes (guillemets) is incorrect for the single guillemets. They 
must be \xdc\xdd .

A more user friendly definition includes the display of the 
used characters:

; Smart Quote Characters
;English       ‘   ’   “   ”
; SmartQuotes=\xd4\xd5\xd2\xd3
;German        ‚   ‘   „   “
; SmartQuotes=\xe2\xd4\xe3\xd2
;French        ‹   ›   «   »         v-- activated
  SmartQuotes=\xdc\xdd\xc7\xc8
;Swedish/Finn. ’   ’   ”   ”
; SmartQuotes=\xd5\xd5\xd3\xd3
;Italian       ‘   ’   “   ”
; SmartQuotes=\xd4\xd5\xd2\xd3

Modifications to maker.ini

Have FrameMaker closed when modifying maker.ini. It is also 
good practice to keep a copy of the original file 
(maker.ini.ori) and make remarks at the beginning of the file 
about the changes, for example:

; 2004-10-12 default zoom factors changed to
; Zoom=28, 36, 50, 74, 90, 125, 200, 353, 500, 1000
; 2006-02-08 Patch b144

Paste prefers text The default for Paste (from none FM files) creates OLE (Object 
Linking and Embedding) connections. To paste the contents 
rather than the object property, change in section 
[Preferences]:

from ClipboardFormatsPriorities=FILE, OLE 2, EMF, META, DIB, 
BMP, MIF, RTF, TEXT

to ClipboardFormatsPriorities=TEXT, RTF, FILE, OLE 2, EMF, 
META, DIB, BMP, MIF

Note: ClipboardFormatsPriorities only affects pasting from the Win-
dows clipboard.  It does not affect the paste operation for con-
tent that is coming from a FrameMaker file.
To paste without formats within FrameMaker use Paste Spe-
cial (CTRL+SHIFT+v) > Text.

Display character 
positions correctly

In section [Fonts] change 

from DisplayUsingPrinterMetrics=Off

to DisplayUsingPrinterMetrics=On

Match colours in 
FrameMaker and PDF

In section [Preferences] change

from GetLibraryColorRGBFromCMYK=Printer

to GetLibraryColorRGBFromCMYK=None

14 This is an error since FM 5.5


